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Teleform	
  Modules	
  

Teleform consists of seven main programme modules: Designer, Automerge Publisher, ScanStation, 
Reader, Verifier, Remote Capture Station and Web Capture Option. Each of these serves a distinct 
function and each has its own icon in the Teleform programme group. 
 
 

Teleform	
  Designer	
  Module	
  

Teleform Designer allows you to: 
• create and edit forms 
• scan and configure existing forms 
• set form attributes and export options 
• define data validation options 
• import and export forms 
• print forms and write scripts 
• specify image processing 
• create detail groups 
• design dropout forms (forms that use dropout ink) 

 
 

FORM	
  TEMPLATES	
  
 
TeleForm makes use of 3 distinct types of Information Templates, namely Form Templates, Document 
Templates and Package Templates. The template you will be using is the Form Template. 
 
A Form Template is a structured form that can be automatically identified by the software’s TeleForm 
Reader module. It makes use of strictly defined data entry fields that can be automatically evaluated by 
TeleForm Reader. The template includes a variety of rules that determine how it will be processed, 
including rules for how form information will be saved. This template is the form that will be used in the 
field, completed and returned to be scanned into Teleform to obtain the information collected on it. 
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Available Form Templates 

When building a Form Template in Designer, you can choose from three 
styles:  

Traditional – These Form Templates are created completely within 
TeleForm Designer. Visually, they have four square "cornerstone" 
Reference Marks and a fixed Form ID block.  

You cannot change the appearance of the Reference Marks or the Form 
ID block, but you can move the Form ID block between the upper left and 
lower right corner. You can also place the Form ID block in both locations. 
TeleForm Reader uses these marks and blocks to: 

• identify an image file as a Form Template 

• locate the Form Template's data entry fields 
 
VersiForms – These Form Templates are created completely within 
TeleForm Designer. Visually, they contain Reference Marks and a Form 
ID feature, like Traditional Form Templates. Also like Traditional Form 
Templates, these marks and Form IDs are used to identify images as the 
Form Template and locate the data entry fields on it. However, VersiForm 
Templates allow you more flexibility in visual design.  

You can edit both the size and appearance of the Reference Marks on 
VersiForm Templates. You can create square, circle, triangle, and angle 
Reference Marks. Although you cannot delete or obstruct the Reference 
Marks, you can move them to different places on the page. For multipage 
templates, each page can use different Reference Mark styles and 
locations. 

You can choose between a text and bar code Form ID, and place it in any 
of the four corners of the template. 
 
Existing – These Form Templates are forms that were first created outside of TeleForm. They might be 
time cards that your company has used for years before you purchased TeleForm, marketing surveys 
created in a sophisticated graphics design program, or any other data-gathering form that is not currently 
automated. Visually, there is no standard appearance for Existing Form Templates.  

To incorporate an Existing Form Template into TeleForm, you must have either a hard copy or an 
electronic image of the form created by the same scanner that you will use to process returned forms. If 
you have only the hard copy, you must create an image of the document using the same scanner that you 
will use to process returned forms.  
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After opening the form image in Designer, you will overlay the existing data entry fields with TeleForm 
data entry fields. Unique drawing objects and text blocks will be used as the equivalent of Reference 
Marks. You can also use unique text on the page to create an Explicit ID to assist Reader in identifying 
the Form Template.  

After your form has been converted, Reader will be able to evaluate images of the Existing Form 
Template, since Reader now "knows" where the data entry fields are located and what type of values 
should be expected in them. 
 

THE	
  DESIGNER	
  WORKSPACE	
  

The Designer workspace is a computerized pasteboard on which you create and configure your form 
template. It comprises the following features. 
 

a. Toolbar Buttons – these provide shortcuts to commands that are also available from the menus. 

 
b. Status Bar – this is located at the bottom of the Designer window. It shows: 
• the number of the page you are currently working on;   
• the position and size of the currently selected object;   
• the type of object that is currently selected.  
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c. Field List - This window lists every Data Entry Field, Index Field, 
and Virtual Field on your template, including those on pages that 
aren't currently shown in the design window. The Show Field 
List command on the View menu and the Toggle Field List 
button allow you to control whether the Field List appears for a 
specific template. By double-clicking a field in this list, you can 
open that field's Properties dialog box. 

 
 
 

 
 
d. Grid and Object Layout Options – These options apply only to 

Form Templates. You can control how your grid and the objects 
on it will appear by changing the settings in the View Options 
dialog box. To open this dialog box, click the View menu and 
select Options. The settings on the View Options dialog box apply 
only to the Form Template that you are currently viewing. 
Therefore, you can modify them independently for each Form 
Template. You can also change the default View Options and 
apply your changes to all future Form Templates by clicking Save 
Default Settings on the Form menu.  

 
 
 
 

e. Data Entry Fields – Designer allows you to create the following types of Data Entry Fields. Each 
field can be customized in terms of appearance and function to meet your exact data collection 
needs. 

 
Constrained Print Fields - These fields are excellent for gathering data such as names, dates, and 
numeric figures. The vertical lines or boxes act as guides for the person filling out the form. 
 
Choice Fields – These fields consist of a single column, or row, of options. Although the choices may be 
simple, such as "Blue," you can export detailed values based on what option is selected. Choice Fields 
can be designed to accept a single choice per field or multiple choices. 
 
Entry Fields – Entry Fields can consist of one or more columns, or rows, of identical choice options, each 
being restricted to the selection and storage of single characters in a particular range, such as A-Z and 0-
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9. When you select an "A" from an Entry Field column, an "A" is written to the database in that position. 
Only one valid choice can be selected per column.  
Capture Zones – These features allow a Verifier operator to find information on a form image or an 
image of an attachment and manually enter that data. 
 
Image Zones – This feature captures a wide range of data, including bar codes, signatures, written 
narrative responses, and even numeric or name data that does not lend itself to a Constrained Print Field. 
 
Signature Fields – These fields are similar to Image Zones, but TeleForm will not perform recognition on 
the data collected in a Signature Field. You can configure these fields to calculate the fill percentage to 
determine whether the form was signed or not, however. If you are using the TeleForm e-Form Option, 
you can use these fields to collect digital signature for online PDF forms. 
 
 

HOW	
  TO	
  CREATE	
  A	
  FORM	
  TEMPLATE	
  

The main purpose of form processing is to capture information quickly and efficiently. The type of 
information to be collected and who the form recipients are should determine the design of the form. 
Questions to consider when planning the design of a form include:  

• the type of Form Template best suited to the information to be captured 

• size limitations of the form 

• the inclusion of graphics such as a logo or picture 

• the inclusion of instructions in the body of the form 

• the type of data entry fields best suited to capture the relevant data 
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Setting Up a Form Template 

 
1. Open Teleform Designer. Under File on the menu bar, select New. 

 
 

2. A window indicating three types of templates is presented. Select the first choice (Form) and click 
OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
3. A Form Type window appears indicating three types of forms with the corresponding preview on 

the left. Select either Traditional or Versiform and click Next. 
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4. A page set up window appears. This window displays the different sizes of paper that can be 

selected for the form as well as the page orientation. Select the appropriate size and orientation 
and click Finish. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. The four marks located at the four corners of the form are Reference Marks and the block located at 
the top left hand corner is the Form ID block. Teleform Reader uses these marks and blocks to identify an 
image file as a Form Template and locate the Form Template’s data entry fields. If you are setting up a 
Traditional Form Template, you cannot change the appearance of the Reference Marks or the Form ID 
block, but you can move the Form ID block between the upper left and lower right corner. To do this, 
select Page Set Up located under Form on the menu bar. Under Marks and Identification, select the 
appropriate Form ID location. 
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If you are setting up a Versiform Form Template, you can change the appearance of the Reference Marks 
or the Form ID block, as well as move the Form ID Block to any of the four corners of the Template. To do 
this, right click on the Form ID Block or one of the Reference Marks and select Properties. Under Form 
ID, choose the preferred location and style of the ID Block and choose the preferred style of the 
Reference Marks from the drop-down list provided. The Reference Marks can also be moved within the 
four quadrants of the Form Template.  
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PLACING	
  SHAPES	
  AND	
  IMAGES	
  ON	
  A	
  FORM	
  TEMPLATE	
  

Designer's Shape menu and the Shape toolbar allow you to add objects to a Form Template.  
 

1. Select an object from the Shape menu or click the appropriate toolbar button. The cursor will 
reflect the shape you selected. Hold down the left mouse button and "drag" the cursor to define 
the size of the shape. 

 
Jpeg and Tiff images can be copied from MS Paint or Photoshop and pasted onto the form being 
designed, and the size adjusted as necessary.  

 
 

 
	
  

	
  

	
  

	
  

	
  

PLACING	
  TEXT	
  ON	
  A	
  FORM	
  TEMPLATE	
  

1. The text tool is located on menu bar. When selected, you drag the cursor over the area on the 
page where you want to type text.  

 
2. Text font, size and alignment can be adjusted by highlighting the text and selecting the desired 

options under Object on the menu bar. Use Caps Lock on your keyboard to type text in 
uppercase. 
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CONSTRAINED	
  PRINT	
  FIELDS	
  

 
Types of Constrained Print Fields 

Constrained Print Fields, also known as Print Fields, provide one dedicated space for each letter, 
number, or character in the response. Each space is bounded by lines to guide the respondents in 
correctly entering data in the assigned spaces. There are three types of Constrained Print Fields:  

Standard Fields consist of sequential boxes.  

 
Comb-Style Fields consist of short lines between each character. You 
can modify the height of the comb lines.  
 
Date Fields can be either full boxes or comb-style in 
appearance, but they include separator characters, 
such as a slash / or dash -, to distinguish between 
the day, month, and year information. Date Fields 
are automatically limited to numeric characters.  
 
How To Create A Constrained Print Field 

1. Click the Constrained Print Field or Comb-style Constrained Print Field toolbar button located 
on the menu bar. You can also select, Constrained Print from the Shape menu and click 
Standard, Date, or Comb. The cursor will change to the Constrained Print Field tool.   
 

2. When you release the mouse button, the Constrained Print Field dialog box will appear. 
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Configuring the Print Field Tabs 

The Field Info Tab consists of the following features: 

• Field ID – Teleform automatically assigns a default Field ID to each new field you create. You 
can replace the default with a more descriptive ID that is relevant to the data you will be 
collecting. The Field ID can be up to 127 characters. Underscore characters ( _ ) will be added if 
you type a space.  

• Description – this field is optional. There is no limit to the length of the Description. 

• Summary – this window displays an overview of the data entry field as it is currently configured. 

• Preview – this window shows the physical appearance of the data entry field as it is currently 
configured. 
 

1. Type a Field ID in the Field ID box. 
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Adding a Title to Data Entry Field 

1. Click the Appearance tab on the data entry field's Properties dialog box and select the Title sub-
tab. If necessary, type a new name in the Title text box.  

2. Make sure the Show title check box is selected.  

3. The Spacing setting determines how far the Title will be printed from the border of the field.  

4. The Position, Justification, and Rotation settings change the appearance of the Title relative to 
the field.  

5. To change the text style of the title, click Font.  

6. Click OK. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 13 

 

Constrained Print Field Format 

The size of a Constrained Print Field is limited only by the page size of the form.  
 
The Template Field defines how many "boxes" will make up the Constrained Print Field. 

1. Type a numeric value in this field. The Constrained Print Field will contain that many "boxes." 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Length Field shows the maximum number of characters that will be exported from the Constrained 
Print Field after the form is evaluated. If the Include template characters (/ $ . -) with data option is NOT 
enabled, the Length will match the number of "boxes" defined in the Template Field. If the Include 
template characters with data option is enabled, the Length will equal the number of "boxes" defined in 
the Template Field PLUS the number of template characters used for the field. For example, the 
Template below includes two separator characters (slashes). Once the Include template characters with 
data option is selected, the Length of characters to be exported will be eight as opposed to six. 
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The Treat as Text option causes data to be exported as text rather than as numbers. This option is 
enabled automatically for fields that are defined as alphabetic or alphanumeric. It can be manually 
selected when the expected characters are numeric, or when you have defined a numeric Template. 
 

 
 
Processing Options – Recognition Tab 

 
Recognition settings define the characters that TeleForm Reader will "expect" to find in Constrained Print 
Fields. Defining the expected characters more narrowly will typically improve recognition, but if you 
disable TeleForm from recognizing certain characters or print styles, you risk losing information should a 
form be filled out in a non-allowed method.   
 
Expected Characters – the AlphaNumeric option provides the greatest flexibility in evaluating returned 
data. However, you can narrow the expected characters and increase recognition accuracy by selecting 
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either Alpha or Numeric, as long as you are confident that the returned fields will ALWAYS contain only 
alphabetic or numeric characters.  
 
You can also specify the location of alpha or numeric data in a field by placing “a” or “n” after the numeric 
value typed in the Template Field. For example, if you type 3a3n in the Template Field, the Reader will 
expect to find three alpha characters in the first three boxes followed by 3 numeric characters in the last 
three boxes. 
 
Hand Print and Machine Print – You can select either or both of these options. Hand print allows 
Reader to recognize printing done by hand. Machine Print (Default) allows Reader to recognize printing 
done by typewriter, printer, or other mechanical source. 
 
Upper Case and Lower Case – the Upper and Lower case check boxes are only available if you have 
selected Alpha or AlphaNumeric from the Expected characters list.  

• Upper case (Default): If you are certain that the returned value for the field will contain only upper 
case letters, you can select this check box and disable Lower case to narrow the expected 
characters and increase your recognition accuracy.  

• Lower case (Default): If you are certain that the returned value for the field will contain only lower 
case letters, you can select this check box and disable Upper case to narrow the expected 
characters and increase your recognition accuracy.  

 
Special Characters – to enable the recognition and/or display of special characters in a Constrained 
Print Field or Image Zone, you must select the Special Characters checkbox. By default, any field on 
which Special Characters is enabled will support ALL the special characters available for the selected 
Expected characters and printing style options. You can further define exactly which special characters 
will be supported by checking the Special Characters dialog box.  
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Prefill and Default Values 

Prefill values let you automatically place information in a data entry field. 
 
Default values let you specify a value that will be exported from the data entry field in the event that field 
is returned completely unfilled. 
 
To prefill a data entry field: 

1. Make sure the Expected Characters option in the Engine Settings is configured to accept the type 
of data with which you will be prefilling the data entry field, i.e. whether numeric, alpha, or 
alphanumeric. 

2. Open the data entry field's Properties dialog box.  

3. On the Appearance tab, click the Prefill sub-tab 

4. Type a value inside the Prefill value box. 

5. Click OK. 
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Once all appropriate selections have been made to suit the requirements of the Constrained Print Field, 
click OK. Your Form Template will now display the configured Constrained Print Field, which can be 
positioned on the form as desired. The Field ID will also be displayed under the Fields icon on the left 
side bar. 
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CHOICE	
  FIELDS	
  

Choice Fields are a list of options. The respondent chooses from these options by selecting the 
appropriate Response Mark. The available types of Response Marks include bubbles, boxes, brackets, 
lines, and the name of the option. Choice Fields can also be designed to accept a single choice or 
multiple choices. 
 
How To Create Choice Fields 

1. Click the Choice Field toolbar button or click Choice Field from the Shape menu. The cursor 
changes to the Choice Field tool.    

2. Click the cursor on the Form Template where you want the Choice Field to appear.    

3. When you release the mouse button, the Choice Field Wizard will appear.  
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4. On the Style dialog box, choose the Response Marks (bubble, box, underline, response, bracket, 

round bracket) you would like to use and click Next.   

5.  On the Arrangement dialog box, choose how you would like the individual choices arranged 
(vertical, horizontal or rectangular) and click Next.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
6. Choose between Manual Entry and Assisted Entry and click Next.  

7. If you select Manual Entry, the Choice Field Wizard will close, replaced by the Choice Field 
dialog box.   
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8. On the final Choice Field Wizard screen, configure the field.   

9. Define how many options you want the field to contain in the Number of choices box.  

10. To change the number associated with the first choice, type a new value in the Start box.  

11. To change the increment between each choice, type a new value in the Increment box.  

12. If you selected a Rectangular layout in step 5, you can use the controls in the Rectangular 
Arrangement Options section to change the appearance of the field.  

13. Select the Number across button to arrange the field in columns. Type a new value in the Wrap 
box to set the number of columns.  

14. Select the Number down button to arrange the field by rows. Type a new value in the Wrap box 
to set the number of rows.  
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15. Choose the Display and Storage values. The options that are printed on a Form are called the 
Display Values. When TeleForm evaluates a form and determines what option has been 
selected, it writes a corresponding Storage Value to the database. The Display Value and its 
corresponding Storage Value do not need to match. 

16. Select the No display checkbox if you do not want to print Display Values on the forms.  

17. You can edit the default text (Choice) in the Prefix and Suffix boxes to create a new Display 
Label. To add a space between the Display Value and the number of the option, press the 
SPACEBAR. You do not need to type a dash or line.  

18. To change the Display Values' appearance, click the Font button.  

19. The Storage controls define what values will be exported to the database. At this point, the 
Storage Values are the numbers of the options in the field. For example, the Storage Value for 
Choice 2 is 2.  

20. The Prefix and Suffix boxes allow you to add characters to the front or back of these default 
Storage Values, but the number will still be included.  

21. Click Finish. The Choice Field dialog box will appear.  
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22. Under Field Info tab, type a name in the Field ID box. 

23. Select the Choice tab to change the display names and values of the data that will be displayed 
and exported. 

24. Click on the first selection. The values highlighted will be displayed in the Display and Store in 
database as boxes above. 

25. In the Display box, type the value label to be displayed on the form e.g. 1 Yes. Click Update. The 
Store in database as value can also be changed as required. Click Update to complete the 
process. The updated values are now displayed under Display and Value in the box below as 
well as in the Preview box. Continue this process until all the choices have been updated. 
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26. Under the Appearance tab, you can select Show Title and change the Title Text to be displayed 
on the form next to the Choice Field. Adjust the format to the text as necessary. 

27. Under Validations tab, check the appropriate selection. Click OK. 
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Multiple Choice Fields 

By default, Choice Fields permit only a single choice. However, this setting can be changed to allow 
multiple responses. 
 
There are three storage options available for multiple responses. 

Single Column Variable – Every marked choice will be stored in a single column in the data file. Two 
space characters will separate each selected choice. No space will be reserved for choices that were not 
selected. For example, if a user chooses two of five possible options, the exported data file will contain 
the two chosen options without separators for the unmarked choices. 

Single Fixed Column – Every marked and unmarked choice will be stored in a single column. Two space 
characters will separate each choice. For example, if there are five choice options in the field, the 
exported data file reserves five positions for the data, using four delimiters, regardless of how many 
choices were actually selected. 

Separate Columns – Each selected choice is stored in a separate column in the data file. In the export 
file, each selected choice will have a "1" in its column while unselected choices will have a "0." 

 
How To Set A Multiple Choice Field 

1. Under the Choices tab, change the value from a numeric character to either include the Field ID 
name before it, or give it a value name. (Multiple choice field values must begin with an alpha 
character). 

2. On the Choice Field dialog box, open the Output tab.  

3. Click the Multiple choices permitted button.    

4. Choose a storage option from the drop list.   

5. Click OK. 
 
If the selected Storage option is Separate Columns, you have to adjust the Store in database as box 
under the Choices tab by copying the Field ID name under Field Info tab and pasting it at the beginning 
of each value in the Store in database as box. This ensures that each value will be entered in its own 
column. 
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Editing Choice Fields 

1. Open the Properties dialog box for the Choice Field. 

2. From the Appearance tab, open the Style sub-tab.   

3. From the Shape list, choose the desired style of Response Mark.  

4. The Font button allows you to change the font that will be used to display the choice values. 

5. Choose a Text position for the display values relative to the Response Marks. 

6. Select Vertical, Horizontal, or Rectangular from the Arrange list. Choosing Manual has no effect.  

7. The Right justify text box aligns the display values by their far right edges. 
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8. Click OK. 
 

 
 
Editing Choices in a Choice Field 

1. On the Choice Field dialog box, open the Choices tab.   

2. In the Display-Value window, select a choice to edit.    

3. In the Display Field, type a new display value for the choice.   

4. If necessary, type a new value in the Store in Database Field. This value is the Storage Value.    

5. Click the Update button.    

6. To change the sequence of the choices, select one in the Display-Value window and use the Up 
and Down buttons.  
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7. Click OK. 
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Adding New Choices to a Choice Field 

1. On the Choice Field dialog box, open the Choices tab.  

2. In the Display Field, type the display value for the new choice.  

3. Type a storage value in the Store in Database Field.  

4. Click Add. If the Update button has replaced the Add button, you inadvertently selected an 
existing choice after opening the Choice tab. After selecting an existing choice you cannot add a 
new choice until you reopen the Choice Field dialog box.  

• Click OK to save any recent changes you have made and to exit the dialog.  

• Click Cancel to prevent any changed you've made since you opened the Choice Field dialog 
from taking effect.  

• You can now reopen the dialog and add a new choice.  

5. Repeat these steps for any additional new choices. 
 
 
Manually Editing a Choice Field 

Changing the Order of the Choices 
You can change the order in which choices appear within the field. For example, you could move the last 
choice to the top of the field.  

1. Hold down the ALT key.    

2. Click the Response Mark and display value combination that you want to move. Grab handles will 
surround the option.    

3. Drag the selected option to its new location.    

4. Repeat steps 1 through 3 for other segments of the Choice Field.    

5. Click anywhere on the form to stop editing the Choice Field. 
 
Resizing a Choice Field 
You can change the spacing between the options in a Choice Field by changing the overall size of the 
field. 

1. Click the Choice Field so that its grab handles appear.    

2. Drag one of the grab handles.    

3. As you drag, the new size is shown by a dashed line. When you release the mouse button, the 
field takes its new size.    
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CAPTURE	
  ZONES	
  

 
Capture Zones provide two special functions when a form is processed in Verifier:  

• A "snapshot" image of the form/attachments being corrected;    
• A special data entry screen.    

 
The "snapshot" image shows the information on the form and any attachments. The special data entry 
field allows Verifier operators to type this data, which will be exported to the storage database configured 
for the Form Template.  
 
Capture Zones are typically used to capture large blocks of printing, cursive writing or images that are too 
poor in quality to be automatically recognized. A Capture Zone allows the Verifier operators to see the 
original response and to type it as alphanumeric data, which results in higher accuracy.  
 
Capture Zones are built from four basic elements:  

• Labels, which identify the purpose of the data entry field;   
• Edit Boxes, which allow Verifier operators to type data;   
• Choice Lists, which allow Verifier operators to choose from a list of defined options; and 
• Freeform OCR Fields, which can be populated automatically or by manual data entry. 

 
 The Capture Zone has its own designer workspace, as you cannot work in the basic Designer window 
once the Capture Zone design window is open. The Capture Zone workspace consists of:  

• The Capture Zone Design Menu: This menu is added to the regular Designer menu bar when 
you open the Capture Zone Design Window. It provides all of the commands available for a 
Capture Zone and the objects within these Zones.    

• The Basic Designer Window: This window shows you the part of the "actual" form on which the 
Capture Zone is located. You can't work in the basic Designer window when the Capture Zone 
Design Window is open.    

• The Capture Zone Design Window: This window is similar to the regular Designer window. It 
serves as an electronic pasteboard on which you can add and arrange objects in the Capture 
Zone. The Status Bar at the bottom of the Capture Zone Design Window shows you the position 
and size of the object that is currently selected in the Capture Zone Design Window.    

• The Capture Toolbar: The toolbar buttons provide shortcuts to commands that are also available 
from the Capture Design menu. 
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How To Create a Capture Zone 

1. From the Shape menu, click Capture Zone, OR Click the Capture Zone toolbar button.  

2. Click and drag the cursor to outline the Capture Zone.    

3. When you release the mouse button, your new Capture Zone will appear.    
 

4. Double-click the Capture Zone. The Capture Zone Design Window will appear. The Capture Zone 
appears as a green rectangle with broken lines. 

5. Select Zone Properties. This window displays and edits the properties of the entire Capture Zone.  

6. Under Field Info, Zone ID, type a name for the zone. 

7. Under Zone Density, you can check the box next to Skip entry if zone not filled in. Put an 
appropriate percentage in the Empty Zone Density box. When this is done, the Verifier will check 
the Zone to verify if the percentage of the zone covered is in-keeping with the valid percentage to 
be filled in, and will either bypass it or allow the entry to be verified accordingly. Click OK. 

8. Once the Zone ID properties have been customized to suit your needs, you can proceed to create 
the appropriate data capture options in the Capture Zone. 
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Unlike other entry fields, the Capture Zone option does not provide the option of naming and displaying 
the title of the field on the form. This has to be done with the Text tool. Lines or boxes also have to be 
drawn to indicate the area on the printed form where the data must be placed. Lines are drawn within the 
Capture Zone box and boxes are drawn the same size as the Capture Zone box. 



 33 

 
 

 
 
How To Create An Edit Box 

1. Follow 1 to 8 under How to Create a Capture Zone. 

2. Click the Edit Box toolbar button or from the Capture Design menu, click Tools — Edit Box.    

3. Move the cursor to the desired position for the Edit Box and click. The Edit Box dialog box will 
appear. 

4. Under the Attributes tab, Field ID, type in a name for the field. 

5. Under Expected Input, make the relevant selections according to the type and style of data you 
are expecting. Select Multi-line and Word Wrap if you expect the data to run onto more than one 
line. 

6. Under the Validations, Output and Prefill tabs, make the relevant selections and click OK. 

• Note that under the Output tab, the maximum length of alpha characters allowed in the Length 
field is 30,000; for numeric fields, Length includes numbers before and after the decimal point. 
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How To Create A Choice List 

1. Follow 1 to 8 under How To Create a Capture Zone. 

2. Click the Choice List tool or open the Capture Design menu and click Tools — Choice list.   

3. Place the cursor within the Capture Zone and click. The Choice List dialog box will appear. 

4. Under the Attributes tab, Field ID, type in a name for the field. 

5. Under Option, in the Predefined Choices box, you can type or paste in a list of specific data 
relevant to that field. The name can consist of letters, numbers, and/or special characters. Press 
enter after each choice is typed in. 

6. You can customize the Choice Field by selecting any of the following options in the window: 

Sort Items – this function allows you to sort alphabetic or numeric lists 

Prefill with Last – the Choice Field will automatically be prefilled with the value from the same 
Choice Field on the last form processed by the Verifier operator. Check this option for Choice 
Lists that change values infrequently between forms. 

Use drop-down list style – this function makes the Choice List appear as a drop-down list rather 
than as a list that is always fully extended. 
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Auto-tab when possible - Verifier will automatically move to the next field in the Capture Zone 
after a Verifier operator selects an item in the Choice List. 

7. Under the Validations tab, make the appropriate selection.  

• If you select the Entry Required option, the Verifier operator will be unable to move out of 
the Choice List until an item is selected.   

• The Allow Free Entry option applies only if the choices are provided from a database. When 
enabled, Verifier operators can type new entries into the Choice List if none of the listed 
choices are appropriate. If you want to capture any free entries made by Verifier operators, 
click the Add New Entries to Text File checkbox. If you do not select this option, the free 
entry will be exported to the data file but will not be stored in a separate file where it will be 
easier to find. Click the Browse button and set up a text (.txt) file for saving a list of any free 
entries made by Verifier operators. 

8. Under the Output tab, make the relevant selections and click OK. Note that in the Output tab, 
the maximum length allowed in the Length Field is 300 for text; for numeric fields, Length 
includes numbers before and after the decimal point. 
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Linking Choice List to a Database 

1. On the Attributes tab, select the From database button in the Data Source section.    

2. In the Database Choices section, click the Modify button. The Select Data Source dialog box 
will appear.   

 

3. Select New. The Create New Data Source window appears. 

4. From the drop down list, choose the data source from which you will be getting your data. Click 
Next. 
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5. In the Create New Data Source window, you can either browse to the location of your data source 
or type in the name of the data source you want to connect to. Click Next, browse to the location 
of the database and then click Save, Next and Finish. 



 38 

6. In the ODBC Setup Window, click Select and locate the database from the directory listing. When 
you select the directory where the database is located, the database name will appear under 
Database Name. Select it there and click OK. 
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7. Click OK in the ODBC Setup Window. 

8. In the Select Data Source Window, the database name will appear. Click on it to make it appear 
as the DSN name. Click OK. 

 

9. In the Select Table and Field window, select the Table and then the relevant Field. Click OK. 
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10. In the Choice List main window, click OK. The database has been set up and can now be 
accessed. 

11. To test that it is available, click the Test button in the Capture Zone Design Mode. This will 
activate the database field and allow you to view the database as the Verifier would. 
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This process can also be done through the OBDC Data Source Administrator in the Administrative Tools.  

1. Under Control Panel, Administrative Tools, select Data Sources (ODBC). 
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2. Choose the System DSN tab and select the relevant database driver. Click Add. 

3. In the Create New Data Source Window, select the relevant database driver again. Click Finish. 

4. In the OBDC Setup window, type in the Data Source Name. Click Select. 

 

5. Locate the database and select the database name. Click OK. 

6. The name you gave the database should be in System DSN list of database drivers. Click OK. 

7. Create a Capture Zone and select Choice List. 

8. Select From Database and Modify. 

9. In the Select Data Source window, click on the Machine Data tab. Select the database you 
named in the OBDC set up. Click OK. 
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10. In the Select Table and Field window, select the Table and then the relevant Field. Click OK. 

11. In the Choice List main window, click OK. The database has been set up and can now be 
accessed. 

 

Freeform OCR Fields 

The Freeform OCR Field lets a Verifier operator specify what text will be captured but uses automated 
recognition to actually capture it. It is used when you cannot be sure where a specific piece of information 
will be found on a file, but you do not want your Verifier operators to spend time typing it into an Edit Box 
once it is actually located. 
 
 
How To Create a Free Form OCR Field 

1. Follow 1 to 8 under How to Create a Capture Zone. 
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2. Click the Freeform OCR Field toolbar button or 0pen the Capture Design menu and click Tools 
— Freeform OCR Field.   

3. Place the cursor within the Capture Zone and click. The Freeform OCR Field dialog box will 
appear.  

4. Change the Freeform OCR Field's properties as needed. 
 
 

 
 

IMAGE	
  ZONES	
  
 
An Image Zone defines and reserves an area on a Form Template for:  

• Evaluating information, such as a name, monetary charge, bar code, or encrypted text;    

• Capturing information, like an image of a drawing, without evaluating it. 
 
How to Create An Image Zone 

1. Click the Image Zone button or click Image Zone on the Shape menu.    

2. Press the mouse button and drag the cursor to set the location and size of the Image Zone.    

3. When you release the mouse button, the Image Zone dialog box will appear.   
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4. Type a name in the Field ID box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Under the Appearance tab, select Show Title and type the text that will appear next to the image 
zone. You can adjust the positioning of the text as well as the font within this same window. 
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6. Under the Style tab, select the lines you want displayed around the Image Zone or if you want the 
Zone transparent. The lines indicate the area in which the information to be obtained will be 
written.  

7. Under the Processing tab, select the Engine Settings tab. Under Expected Characters, make the 
appropriate selections that would indicate the type of characters to be expected i.e. alpha, 
numeric, alphanumeric, hand or machine print, upper or lower case or special characters. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Under the Output tab, select Store Value and input the maximum number of characters to be 
expected in the Length box. 

9. Under the Validations tab, you can make the appropriate selections that might be needed to 
validate data collected e.g. Entry required means that the form will not be accepted if data is not 
entred in the field, but will be held for review in the Verifier module. 

10. Once you have configured the Image Zone to suit your needs, click OK. 
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SIGNATURE	
  FIELDS	
  

These fields are similar to Image Zones, but TeleForm does not perform recognition on the data collected 
in a Signature Field. You can configure these fields to calculate the fill percentage to determine whether it 
was signed or not, however.  

Signature Fields are of particular value on PDF forms, since Adobe Acrobat supports digital signatures 
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How To Create a Signature Field 

1. Open your Form Template in TeleForm Designer.    

2. Click the Signature Field tool or from the Shape menu, click Signature Field.  

3. The cursor will change to the Signature tool.    

4. Click the cursor at the desired location and drag to outline the boundaries of the field.    

5. The Signature Field dialog box will appear. 
 

 

6. Under the Field Info tab, type in a name in the Field ID box. 

7. Under the Appearance tab, select Show Title and type in the title that will be displayed on the 
form, next to the field. Make the relevant adjustments to the style of the title. 

8. Under the Style tab, select the type of frame you want the signature written in on the form i.e. 
whether a complete box or just a line. 

9. Apply the selections required, if any, under the Validations tab. 

10. The following options are available under the Output tab: 
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• Store Image – a separate graphic image of the field will be stored in the TeleForm\IMG 
subdirectory. Your export database will show the name of the image file under a column 
named "PCX_Field ID." For example, if the Field ID is "Signature," the path to the image file 
will be shown in a column named "PCX_Signature." The exported image file will be saved in 
the specified Format. 

• Format – this list allows you to choose the specific format in which the image collected from 
the Image Zone or Signature Zone will be saved. 

• In database (if supported) – if your database supports the storage of images, the graphics 
files will be saved directly to your database. Your database must be capable of storing Binary 
Long Object (BLOB) data formats. While many databases can store these formats, they may 
not have the capability to display the data while in the database. 

• Don’t store if blank – this option avoids the creation of image files of empty fields. 

• Store value – this option evaluates how much of the field is filled and exports the resulting 
value to your database. For example, if the returned value occupies 3.9% of the available 
space in the field, a value of 3.9 would be exported to your database after the form is 
processed. 
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ENTRY	
  FIELDS	
  

An Entry Field contains rows or columns of “Response Marks” or bubbles where each Response Mark is 
tied to a specific value. This type of data field is used is commonly used in filling out credit card numbers 
or any other similar form of information.  
 
How To Create an Entry Field 

1. Select the Entry Field toolbar button or Entry from the Shapes menu. 

2. Click the cursor on the area of the form on which you want the field to appear. 
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3. When the Entry Field window appears, select the appropriate field properties as needed. 

 

SIGNATURE	
  FIELDS	
  

These fields are similar to Image Zones, but TeleForm does not perform recognition on the data collected 
in a Signature Field. You can configure these fields to calculate the fill percentage to determine whether it 
was signed or not, however.  

Signature Fields are of particular value on PDF forms, since Adobe Acrobat supports digital signatures 
 
How To Create a Signature Field 

1. Open your Form Template in TeleForm Designer.    

2. Click the Signature Field tool or from the Shape menu, click Signature Field.  
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3. The cursor will change to the Signature tool.    

4. Click the cursor at the desired location and drag to outline the boundaries of the field.    

5. The Signature Field dialog box will appear. 

 

6. Under the Field Info tab, type in a name in the Field ID box. 

7. Under the Appearance tab, select Show Title and type in the title that will be displayed on the 
form, next to the field. Make the relevant adjustments to the style of the title. 

8. Under the Style tab, select the type of frame you want the signature written in on the form i.e. 
whether a complete box or just a line. 

9. Apply the selections required, if any, under the Validations tab. 

10. The following options are available under the Output tab: 

• Store Image – a separate graphic image of the field will be stored in the TeleForm\IMG 
subdirectory. Your export database will show the name of the image file under a column 
named "PCX_Field ID." For example, if the Field ID is "Signature," the path to the image file 
will be shown in a column named "PCX_Signature." The exported image file will be saved in 
the specified Format. 
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• Format – this list allows you to choose the specific format in which the image collected from 
the Image Zone or Signature Zone will be saved. 

• In database (if supported) – if your database supports the storage of images, the graphics 
files will be saved directly to your database. Your database must be capable of storing Binary 
Long Object (BLOB) data formats. While many databases can store these formats, they may 
not have the capability to display the data while in the database. 

• Don’t store if blank – this option avoids the creation of image files of empty fields. 

• Store value – this option evaluates how much of the field is filled and exports the resulting 
value to your database. For example, if the returned value occupies 3.9% of the available 
space in the field, a value of 3.9 would be exported to your database after the form is 
processed. 
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DETAIL	
  GROUPS	
  

Detail Groups allow you to instantly create repetitious rows of data entry fields. Rather than creating 20 
separate data entry fields, you can create the first row of four data entry fields, then build a Detail Group 
from these items.  
 
The information collected from a Detail Group is exported to a separate database file from the other data 
on the Form Template. Each row of the Detail Group becomes a separate record in this "extra" database 
file.  
 
 
How To Create A Detail Group 

1. Add the first row of data entry fields to your Form Template. These fields can consist of all of the 
data entry fields except for Capture Zone. This row will be repeated to make up the Detail Group.  

2. Do not add headings to the data entry fields in the first row unless you want them displayed in 
every row. Create headings from text object tool. 

3. Any validation, processing, output or other properties you set for the data entry fields will be 
applied throughout the Detail group. 

 

 

4. Select all the fields in the row. You can band around them with the cursor or hold down the CTRL 
key and click each field. 

5. On the Object menu, click Make Group — Detail Group. The Detail Group dialogue box will 
appear. 
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6. On the Field Info tab, type a descriptive Field ID for the Detail Group. You can add a text 
Description of the Detail Group as well. 

7. Click the Appearance tab. 

8. In the Rows box, type in the number of copies of the first row you require. 

9. The Separation setting defines how much space will be inserted between each row. It is 
measured in 1000ths of an inch. 

 

 
 
 



 56 

 
 

10. One or more of the regular data entry fields on the Form Template must be designated as Key 
Fields. These fields link the data collected from the main parts of the Form Template to the data 
collected in the Detail Group since this latter data is exported to a separate file. Data collected 
from Key Fields is exported to the Detail Group's database file as well as the Form Template's 
regular database file, providing a common link between databases. 

11. Select a field from the Available list and click the Add button. The field will appear in the Key 
Fields list. Repeat this step for every field that you wish to use as a Key Field. 

12. To remove a Key Field, select it from the Key Fields list and click the Remove button. 
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How To Edit Fields in a Detail Group 

1. Click the Fields tab on the Detail Group dialog box.   

2. Select a field in the Tab order or Disabled windows.   

3. Click Properties.  

4. The selected data entry field's Properties dialog box will open.  

5. Edit the field's properties as needed. 

6. Click OK and the Detail Group dialogue box. 
 
 
How To Set The Tab Order In A Detail Group 
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The Tab Order defines the sequence in which fields within a Detail Group will be visited if they are held 
for review in Verifier. Typically, a Detail Group is set up to read from left to right, which is easy for a 
Verifier operator to process. 

1. Open the Fields tab on the Detail Group dialog box. 

2. Use the Add button to move fields from the Disabled list to the Tab order list.    

3. Use the Remove button to move fields from the Tab order list to the Disabled list.    

4. Use the Up or Down buttons to change the sequence of fields in the Tab Order list. The first field 
listed in the Tab order window will be the first field seen by a Verifier operator if the Detail Group 
is held for review.  

5. Click OK. 
 
 

DATA	
  GROUPS	
  

A Data Group is a combination of data entry fields (except Capture Zone) that are grouped together and 
whose values are exported to a single data group column in a database. Data Groups put together fields 
that have been split into several data fields. You can create a Data Group that combines two individual 
fields for an address or three individual fields for collecting information on day, month and year. When the 
Data Group field is exported, it will store a single date value in the database. 
 
Data entry fields in a Data Group retain their individual properties. You can edit the attributes of each 
component field without first breaking the group. 
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How to Create a Data Group 

1. Select each of the fields that you wish to include in the data group. You can select any 
combination of data entry field.    

2. On the Object menu, point to Make Group and then click Data Group. The Data Group dialog 
box will appear.   

3. In the Field ID box, enter a name for this data group.    

4. To change the order in which the data from a field will be exported, select it from the Data fields 
list and click the Up or Down buttons. These buttons do not affect the physical layout of the fields 
on the Form Template. 
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DROPOUT	
  COLOURS	
  

Dropout colours are printed in special color ink that is "invisible" to your scanner because the scanner is 
equipped with a colored bulb. Using a properly configured scanner, the coloured background disappears 
and the Reader sees only the data.  
 
An example of when dropout colours are most effectively used is in the case of constrained fields that 
have been configured for hand recognition and where there is the high possibility that handwriting would 
touch the edges of the constrained boxes. After these fields have been scanned, the Reader removes the 
lines around the data so that pieces of data would be lost. These fields would then have to be sent to the 
Verifier to be corrected. Dropout colours would ensure that all data written into the constrained fields are 
captured by the Reader. 
 
How to Create Dropout Colours 

1. Select the data field you want in dropout colours. 

2. Under Form, select Dropout forms – colours. A colour palette will appear from which you choose 
the colour you want to use. Blue and red are the colours used for dropout colours. 

3. Under Object, select Drop Out. This will change the colour of the data field. 

4. In the Properties of the data field, select the Appearance tab and then the Dimensions tab. 

5. In the line width option, select Field level and change the width of the field to thicken the lines of 
the data field. Click OK. 

6. o remove dropout colours, deselect Drop Out under Object and change the line width back to 
System Level which is 15. 
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SAVING	
  A	
  FORM	
  

One of the most important tasks to perform once you have started designing a Form Template is to save 
it. It is advisable that you save your Form Template immediately after setting up the Template.  

1. Select Save under File on the menu bar, or click on the Save icon. 

2. The Save As window opens. 

3. Type in a name in the Title box. This will be the name of the Form Template. 

4. You can fill in Password and Description if you require special security for the Form Template. 

5. Next to the Folder box, click on Select. This will open up the Select Folder window from which 
you will either create a new folder for your Form Template, or use any other folder that exists in 
the list of folders. 
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6. When you have chosen a folder in which to save your Form Template, click OK. You will return to 

the Save As window which will now indicate the name of the Folder in which the Form Template 
will be saved. Click OK. 
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ACTIVATING	
  A	
  FORM	
  

While in the process of designing a Form Template, the form is saved in Draft mode. Once you have 
completed the design of the Template, you must activate the form in order to release it from the design 
phase to the production phase i.e. using it to collect information. Teleform cannot process a form unless 
the matching template has been activated. Forms that have not been activated before distribution will be 
treated as Non Forms by the Reader. 
 
Once a Form Template has been activated, you will not be allowed to add, move, or delete any data entry 
fields. Because of this, "activating" should be among the last actions you perform on your Form Template. 
After activation, you should test your form before distributing it for actual use. 
How to Activate A Form Template 

1. Open the template in Designer. 

2. Save the template.  

3. From the Form menu, click Activate. The Activate command will be unavailable for a Form 
Template if the template has not been saved yet.  

4. Designer notifies you that activating the template will prevent further changes to it. 

5. Click Yes.  

6. Another Note will appear. Click OK.  
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7. Save the template. 
 
 
Resaving Activated Form Template 

In the event that you have to physically modify data entry fields on the activated Form Template, once 
you try to save the changes you made, you will be prompted to save the form under a different name. 
 
 
 
 
 
 
 
 
 
If you choose to do so, you will have to reactivate the new form.  
 
However, this process can be avoided by overriding the Save As feature by doing the following: 

1. Select Configuration, under Utilities on the menu bar. 

2. The Global and Local Teleform Settings window will appear. Select the Designer tab. 

3. Under this tab, select the Advanced tab. 

4. In the General block, select the Skip ‘Save As’ dialogue for activated templates box. Click 
OK. This disables the Save As prompt and allows you to save the changes made on the Form 
Template. 

5. Save the Form.  
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TESTING	
  FORM	
  TEMPLATES	
  BEFORE	
  ACTIVATION	
  

After designing a form template, it is always advisable to test it before activation for its intended use. This 
would ensure that all fields are collecting the data required and in the manner intended. This process is 
conducted in the Verifier module. 
 

1. Open the Verifier Module. 

2. Under the Batch Management Dialog window, under Utilities, select Non form data entry. 

 
A Select Template(s) window will appear. This window displays all the Form templates you have 
created in the Designer Module.	
  

 
3. Select the Form Template you want to test. Click OK. The form will appear in a new window for 

you to fill in the fields.	
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4. When you have entered data in all the fields, you will be prompted to Save corrections to results 
file. Click OK. The data will then be exported to the database you set up in the auto export set up 
in the Designer Module. You can then view the data to ensure its quality. During the data entry 
process, you will also be able to pinpoint which fields need adjusting in the Designer module e.g. 
if a numeric field has been set up to accept alpha characters or if the length of a field needs to be 
increased. 

 
 
 

CHANGING	
  THE	
  DATA	
  ENTRY	
  FIELD	
  ORDER	
  

The Data Entry Fields created on the Form Template are viewed in the left column of the Designer 
window. These fields are also viewed in Fields under Form on the menu bar.  
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The Fields tab controls the Field Order for the template. The Field Order sets the default field export order 
for the template. It is based on the order in which fields are added to a template. This order can be 
modified as required. 
 
How to Change the Field Order 

1. Select the field you want to move by clicking on it. To select multiple fields, hold down the CTRL 
key while you click each one. To select a range of fields, click the first one, hold down the SHIFT 
key, and click the last one. 

2. To move the selected field(s) to a new position in the Field Order, click the Up and Down buttons. 

3. The commands in the Sort list will change the positions of ALL the fields on the template. 
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How to Change the Tab Order 

The Tab Order defines the order in which the fields on a template will be visited if the template is held for 
review in Verifier, or if it is exported to HTML or PDF formats. If you do not edit the Tab Order, it will be a 
duplicate of the Field Order.  

1. Select the field you want to move by clicking on it. To select multiple fields, hold down the CTRL 
key while you click each one. To select a range of fields, click the first one, hold down the SHIFT 
key, and click the last one. 

2. The Included column shows every field currently in the Tab Order. Moving any field, including 
Virtual Fields, to the Included column does not mean that a Verifier operator will always have to 
correct that field if the template is held for review. A data entry field that is part of the Tab Order 
will only be visited in Verifier when the data collected from it is suspect. Select the field you want 
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to include or exclude and click on the left or right double arrows to move it from one column to the 
next. 

3. The excluded column shows fields that are not currently part of the Tab Order. These fields will 
be removed from the Field List when the template is corrected in TeleForm Verifier and 
respondents will not be able to enter data in these fields if the form is published to PDF format. 

4. The commands in the Sort list will change the positions of ALL the fields currently Included in the 
Tab Order. Fields at the top of the Included column will be visited in Verifier and on electronic 
versions of the Form Template earlier than those listed below them. 

5. If you click on Copy Field Order, the sequence of fields defined on the Fields tab will be 
automatically copied to the Tab Order. Fields that were excluded from the Tab Order will still be 
excluded after they are copied from the Field Order. 
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AUTO	
  EXPORTS	
  

Teleform’s Auto Export feature gets the data that has been collected into a database or exports the form 
as an image into PDF format. 
 
How To Set Up An Export To A Database 

1. Open the template in Designer. 

2. From the Form menu, click Auto Export Setup or right-click an empty area of the template and 
select Auto Export Setup. 

3. To create a new auto export, click the New button. To modify an existing Auto Export, select it 
and click the Modify button.  

4. A second Auto Export Setup dialog box will appear.  

5. Choose a database Format and click the Save as button. (TeleForm would automatically create 
most databases from the list. Empty Access and SQL databases will have to be created 
beforehand as TeleForm does not create these automatically). 

6. Select the folder to which you will be exporting the data collected and enter a name in the File 
Name box. Click OK. 

7. Select the Enable check box to activate the Auto Export.    

8. The following Settings are optional: 

• Fail commit if this export fails – this function works if an item being processed is part of a 
batch (a set of files processed together instead of separately). When it is enabled, data will 
be exported up until the point of failure 

• Disable export locks – certain export database formats will enable this feature 
automatically. This allows multiple Verifier stations to export data to the file at the same time. 

• Include header – certain export database formats will enable this feature automatically. This 
feature allows Field ID’s to be exported as the first record or row in the database. 

• Conditional export – this feature forces TeleForm to skip the Auto Export of a template if the 
value of a field on that template matches a specified criterion. This function works on the level 
of individual files, not batches. 
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9. Click on Fields tab. 

10. Under the Enabled column, check the boxes next to the Field ID you want exported to the 
database and uncheck those that you do not want exported. You can select multiple fields and 
press the SPACEBAR to disable them all. You can also select multiple fields and deselect the 
Enable check box for any one of them. All of the selected fields will then be disabled. 

11. Under the Database column, you can rename the items in the list if you are setting up an export 
to a new database. Double click the item you want to rename or highlight it and type the new 
name. 

12. The Automap button searches for matches between the database columns and the template 
fields. When it finds an exact match, it will map the template field to the database column 
automatically. 

13. When you have finished configuring the Fields tab, click OK. 
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How To Set Up An Export To PDF Format 

1. Open the template in Designer. 

2. From the Form menu, click Auto Export Setup or right-click an empty area of the template and 
select Auto Export Setup. 

3. To create a new auto export, click the New button. To modify an existing Auto Export, select it 
and click the Modify button.  

4. A second Auto Export Setup dialog box will appear. 

5. Choose Capture to directory V2 in the Format box. 

6. In the Settings box, choose Enable. 

7. PDF images can be automatically given unique names when exported. Click Save As and under 
Image Naming in the window that opens up, check the box Name images based on value of 
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form field and then select a field. The data from this field will be extracted to name the PDF 
image exported. Click Done when you are finished. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Under File Export, browse to the directory to which you will be exporting the PDF images. 

9. You have the option of checking the Use the data from this field as a subdirectory box and 
selecting a field, the data from which will give an unique name to a subfolder created for the 
export of the PDF images. 

10. Under Image File Conversion, select PDF as the format. 

11. The default in the Options box is monochrome, which means the PDF will be exported in black 
and white. The other option is colour (if present). 

12. The Page Option block allows you to specify how the files (images and non-images) associated 
with the template will be exported. Select Export all pages (both forms and non-forms) as you 
want all the pages in the form template to be printed to PDF. 

13. The Page Order options define the export order of form/document and attachment images. For 
PDF export, you can leave this selection on the default (Group form pages at the beginning). 

14. Click OK. 

15. Note that in order to be able to select a field for either the naming of the PDF image or the 
creation of a subfolder, at least one field must be enabled under the Fields tab. 

16. Once back in the Auto Export Setup window, click OK to exit. 
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17. Under File Export, browse to the directory to which you will be exporting the PDF images. 

18. You have the option of checking the Use the data from this field as a subdirectory box and 
selecting a field, the data from which will give an unique name to a subfolder created for the 
export of the PDF images. 

19. Under Image File Conversion, select PDF as the format. 

20. The default in the Options box is monochrome, which means the PDF will be exported in black 
and white. The other option is colour (if present). 

21. The Page Option block allows you to specify how the files (images and non-images) associated 
with the template will be exported. Select Export all pages (both forms and non-forms) as you 
want all the pages in the form template to be printed to PDF. 

22. The Page Order options define the export order of form/document and attachment images. For 
PDF export, you can leave this selection on the default (Group form pages at the beginning). 

23. Click OK. 

24. Note that in order to be able to select a field for either the naming of the PDF image or the 
creation of a subfolder, at least one field must be enabled under the Fields tab. 

25. Once back in the Auto Export Setup window, click OK to exit. 
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How To Set Up The Export For Detail Groups 

1. Open the Form Template in TeleForm Designer. 

2. From the Form menu, click Auto Export Setup. 

3. On the Auto Export dialog box, select an Auto Export that has already been configured and click 
Modify.   

4. A second Auto Export Setup dialog box will appear. Click the Detail Groups tab.   

5. Select the Detail Group and click the Setup button.  

6. Another Auto Export Setup dialog box will appear. This dialog box only affects the selected 
Detail Group. 

7. Make the appropriate settings on the Main tab. 

8. Click Save As and select the folder to which the Detail Group will be exported. 
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9. Open the Fields tab.  

10. Select the Enabled check box for each data entry field within the Detail Group. You may choose 
not to export data from some data entry fields in the Detail Group, but this is rarely done. 

11. Click OK on the Auto Export Setup dialog boxes for the Detail Group and the "parent" Auto 
Export. 

12. Make sure that the "parent" Auto Export is enabled. 

13. Save the Form Template.   
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MULTIPLE	
  PAGE	
  TEMPLATES	
  

 
How To Insert A New Page 

1. Open the Form Template in Designer.  

2. From the Edit menu, click Insert Page.  

3. Choose one of these options:  

4. Before current page  
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5. After current page  

6. Before first page  

7. After last page  

8. A new page will be added to the Form Template at the location you specified. 
 
 
How To Delete A Page 

1. Open the Form Template in Designer. 

2. Navigate to the page you want to delete.    

3. On the Edit menu, click Delete Page.    

4. A Note will appear, asking you to confirm that you want to delete the page. Click Yes. The page 
will be deleted. 

NB. Once a page is deleted, there is no way to recover the deleted material. 
 
 
How To Repeat Objects On All Pages 

Text, shapes or graphics that are placed on the first page of a Form Template, can be repeated on all 
subsequent pages. This function is useful in the creation of headers, footers, repetitive instructions and 
logos. 

1. Open the Form Template in Designer. 

2. On page 1, select the object you want to repeat on all other pages.  

3. On the Object menu, click Repeat on all Pages. The object will now appear in the same location 
on every page of the Form Template.  

 
Please note the following: 

• The Repeat On All Pages function does not apply to data entry fields. 

• Repeated objects always appear behind any other objects or text in subsequent pages. 

• Only the object on the first page of the Form Template can be moved or edited. The 
following pages simply mirror what is done to the objects on the first page i.e. the 
appearance and location of the object. 

 
 
How To Improve Identification of Multi-page Form Templates – Page Link Field 

A  Page Link field allows every copy of a returned multi-page Form Template to have a unique value. 
This unique value allows Teleform to accurately identify what pages belong together and is especially 
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handy if pages become separated or mixed up during scanning. Page Link fields are therefore used 
when: 

• Processing multi-page forms; 

• Portions of a multi-page form are received in separate transmissions; and 

• Many forms are scanned at one time, with no separator. 
 
 
How To Create A Page Link  

1. Go to page 1 of the Form Template.    

2. Create a Constrained Field or Image Zone and place it in an appropriate location on the form, 
either the top or bottom corners. 

3. The Constrained Field would usually contain a numeric value, with the number of boxes 
equivalent to the number of expected forms to be printed. An Image Zone would remain blank. 

4. On the Object menu, click Page Link. This command will be unavailable if the object you 
selected is not a data entry field or if you are on any page other than page 1.    

5. A check mark appears next to the Page Link menu item to indicate that this field has been 
selected as the Page Link field.    

6. The selected data entry field will be repeated on all subsequent pages.  

7. Do NOT create more than one Page Link field per Form Template. 
 
 
How To Create A Page Link Using A Barcode 

1. Go to page 1 of the Form Template.    

2. Create an image zone and place it in an appropriate location on the form, either the top or 
bottom. 

3. Under the Field Info tab in the Image Zone window, name the image in the Field ID box e.g. 
PLINK to signify page link. 
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4. Click on the Appearance tab and then the Style tab. Select Transparent frame. This selection 
makes the Image Zone box invisible on the printed form. 
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5. Click on the Processing tab. In the Recognition box, select Barcode from the dropdown menu. 
The Engine Setting window will then change to present selections to be made for setting up the 
barcode on the form template. 

 

 

 

 

 

 

 

 

 

 

 

 

6. Under Bar Code Type, choose the option Select. This will allow you to select the type of barcode 
you prefer to use from a set list. Select EAN 8 from the list. The orientation selection determines if 
the barcode will be set to read horizontally or vertically on the form template. 
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7. Click on the Appearance tab and select the Prefill tab. Click the Barcode button. 

8. The Bar Code Style window appears. The type of barcode you selected will be displayed in the 
Type box as well as an example of how the barcode is to be structured. You can select the type 
of resolution for barcode recognition and whether the actual code will be displayed on the Form 
Template. Click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

9. The Prefill window reappears. Within the Prefill Value box, type in the appropriate number of 
digits as given in the example in the Bar Code Style window. 
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10. Click the Processing tab and then the Test tab. This Test window allows you to test the barcode 
you set up to ensure that the barcode was set up properly. When you click the Test button, the 
Evaluate Test Result window should display the barcode number you typed in the Prefill Value 
box above. The Preview window also displays what the barcode looks like on the Form Template. 
Click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

11. Select the barcode Image Zone. Under Object on the Form Template menu, select Pagelink. The 
barcode will then become the pagelink and will be repeated on all subsequent pages. 

• NB. If the barcode is not properly created, the Evaluate Test Result window will remain emply 
and the Preivew window will display a patchwork patterned box. This result is usually caused 
because the size of the Image Zone is too small and has to be enlargened to suit the size of the 
barcode. 
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EXISTING	
  FORMS	
  

An existing form is any form that is either not created in the Designer Module, or created in the Designer 
Module but printed and put into use without being activated. The Existing Form Template allows the 
external form to be scanned into the Designer and overlays of the various field types to be placed on the 
areas on the form from which data is to be extracted and placed into a database. 

 
How to Create an Existing Form Template 

 
1. Open Teleform Designer. Under File on the menu bar, select New. 

2. A window indicating three types of templates is presented. Select the first choice (Form) and click 
OK. 

3. A Form Type window appears. Select Existing and click Next. 

4. In the Existing Form Source window, select whether you will be scanning in an existing image 
from a directory or scanning new images from a scanner. 

5. If scanning from a scanner, select the approriate page size and orientation in the scanner setting. 

6. Click Finish. The background image of the Form Template will appear in the Designer window. 

7. Save the form. 
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Checking Reference Marks on Existing Form Template 

TeleForm automatically creates Reference Marks on the image of your Existing Form Templates. These 
reference marks act as the ID blocks and Reference Marks in Traditional and Versiform Templates as 
they identify incoming images as this Form Template.  
 
These Reference Marks consist of red lines which are call Identification Lines and blue lines called 
Reference Blocks. 
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Good Identification Lines are drawn over solid lines and are not obstructed by data fields that are to be 
overlaid with Teleform data entry fields. Good Reference Blocks are drawn around images that remain 
constant on multiple returned forms. Such images include titles and graphics.  
 
How to Disable Reference Blocks 

Reference Blocks should not be drawn around data entry fields from which data would be extracted or 
barcodes that would change from form to form.  

1. Double-click the Reference Block. A Note window will appear asking whether to disable the block. 

2. Click Yes. The Reference Block will now be displayed as a dashed blue line and not a solid blue 
line. 

3. The same procedure is followed to disable Identification Lines. 

 
How to Enable Reference Blocks and Identification Lines 

1. Follow the same procedure used to disable these Reference Marks. 

2. To enable multiple Reference Blocks, under Form on the menu, select Re-classify. Designer will 
restore all Reference Blocks that were disabled. 

 
What Are Explicit ID Fields 

Explicit ID Fields are used in Existing Form Templates to a) identify an Existing form either because it is 
too similar in appearance to another Existing Form Template or the Reference Blocks are not sufficient to 
allow the  Reader to identify it; and b) act as reference marks to identify other fields on dropout Existing 
Form Templates. 

 
How To Set Up Explicit ID Fields 

1. Click the Explicit ID icon on the menu bar or from under Shapes in the menu bar. 

2. Drag the Explicit ID box over the text or barcode you want to use as your unique identifying mark 
for the Form Template. 
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3. In the Explicit ID Properties window, select whether text or barcode in the Field Type box. 
The Value box will display the text or barcode selected and evaluated as the Explicit ID. 

4. In the Form Identification Processing box, select how and when the Reader is to evaluate 
the Explicit ID in processing the Form Template.  

5. The Dropout Form Processing box is selected only when using dropout colours in 
Existing Form Templates. This type of Explicit ID field cannot identify the form, but is 
used to define the relative location of other objects on the Existing form. This option takes 
advantage of a name field, which is always printed in the same place but will never 
contain the same value from one form to another. 

6. Click OK. The Explicit ID Field will be marked as a green box on the Form Template. 
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How To Overlay Data Entry Fields 

In order for the Reader to evaluate and export data from an Existing Form Template, Teleform data entry 
fields must be placed over the data entry fields on the Form Template. This process is called overlaying 
or banding. This automated process creates a Teleform data entry field based on the image of the 
existing data field on the Form Template. 

Fields that resemble Teleform data entry fields are easy to replicate. These include constrained and 
choice fields. Image Zones are used to overlay fields that contain free form writing. More complex data 
entry fields that cannot be captured through the above data entry fields can be captured used Capture 
Zones. 

Overlays can be easily sized and positioned to fit over the background image. 

1.  Identify the type of data entry field that best matches the field to be overlaid e.g. constrained, 
choice, image zone or capture zone. 

2. Select the field type from the shortcut icons on the menu bar or under Shape on the menu bar. 

3. Hold down the left mouse button and drag the data entry field cursor around the perimeter of the 
existing field. 

4. Release the mouse button. 

If TeleForm is able to correctly identify the type and shape of overlay field, it will automatically create a 
corresponding data entry field on top of the background image. If not, you will need to manually edit the 
overlay field. In the example below, an Image Zone and Constrained Fields were used to overlay the 
corresponding data entry fields. 
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How To Link Multiple Pages of Existing Form Templates 

Image Zones are used to link pages in Existing Form Templates.  

1. Go to page 1 of the Form Template.    

2. Create an Image Zone and place it in an appropriate location on the form, either the top or bottom 
corners. 

3. On the Object menu, click Page Link. This command will be unavailable if the object you 
selected is not a data entry field or if you are on any page other than page 1.    

4. A check mark appears next to the Page Link menu item to indicate that this field has been 
selected as the Page Link field.    

5. The selected data entry field will be repeated on all subsequent pages.  

6. Do NOT create more than one Page Link field per Form Template. 

7. Open the Form menu and click 'Script'.  This causes the form script editor to display on the screen.   

8. Locate the Sub Form_Evaluate entry point: 

 Sub Form_Evaluate 

 End Sub 

9. Add the following lines inside the Sub Form_Evaluate entry point so that it looks like the 
following.  (This script assumes a 2 page form.  When entering your script, replace the number 
"2" with the actual number of pages on your form).  

 Sub Form_Evaluate 

 Dim PagesPerForm As Integer 

 PagesPerForm=2 

 PLINK.Text=Str$(Val(BatchPgNo.Text)\PagesPerForm)  

 End Sub 

10. Compile the script (File menu - Compile).  

11. If you entered the script correctly and added the page link field called 'PLINK' to your form, you 
should see the string 'Compiled OK' displayed in the status bar at the bottom of the script editor 
window. 

12. Save the compiled script (File menu - Save). 

13. Exit the script editor (File menu - Close).  

 


